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Chapter 1 

AppsRules Suite Installation Overview  

The AppsRules Suite is a set of five integrated applications that work with Oracle 
Applications to define business processes, enhance security, and safeguard data 
integrity: 

• AppsForm modifies the security, navigation, field, and data properties of Oracle 
Applications forms. 

• AppsFlow works with Oracle Applications Workflows to define and implement 
business processes. 

• AppsAudit tracks changes to the values of fields in database tables and displays 
reports that present information about changes to each field. 

• AppsControl applies change control to Oracle Applications fields — it can moni-
tor change, require a reason for a change, or require approval for a change. 

• AppsAccess defines and detects segregation-of-duties conflicts, either preventing 
them from occurring or uncovering them so that they can be properly managed. 

These applications are installed on the database and forms servers on which Oracle 
Applications run. The installation process implements the following architecture: 

• Database Schema: Installation requires the identification of a schema for use by 
LogicalApps applications. LogicalApps recommends strongly the creation of a 
new schema named XXLAAPPS. However, a user who has already established a 
schema for third-party products may choose to use that schema instead.  
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• Tablespace: LogicalApps recommends creating a tablespace for indexes used by 
LogicalApps database objects. (An already established tablespace may be used.)  

• Database Objects: AppsRules makes use of database tables, packages, sequences, 
and workflows, which are placed in the XXLAAPPS (or user-specified) schema. All 
LogicalApps table names begin with the prefix LA.  

• Application Server Objects: AppsRules uses custom forms, which are installed on 
the application server. Custom forms are located in the $XXLAAPPS_TOP/forms/US 
directory.  

• Program Executables: AppsRules uses program executables to report on, migrate, 
and compile business rules. The following objects are installed on the concurrent 
manager server (typically the database server): reports, programs, and Java files. 
Custom programs are located in the $XXLAAPPS_TOP/forms/US directory; some 
executable programs may also reside in the $XXLAAPPS_TOP/bin directory. 

LogicalApps provides two comprehensive Installer programs that place AppsRules 
applications on the database and forms servers. (In addition, they install AppsCore, a 
rules engine that provides functionality to the applications.) Each Installer may be 
run in any of three modes: 

• GUI: The Installer programs present a series of windows that prompt you to pro-
vide information necessary for the installation. Each window also provides access 
to a help file. As you progress through the windows, you can return to windows 
you had completed earlier in order to review or change the entries in them. (The 
Installers retain any entry you don’t change, even if you return to a step earlier 
than the one in which such an entry was made.) GUI mode is the default. 

• Console: The Installer programs present a series of command prompts in a UNIX 
console, in response to which you provide information necessary for the installa-
tion. Console mode prompts for the same information as GUI mode, but does 
not enable you to return to earlier prompts and does not provide help screens.  

• Silent: The Installer programs read parameters from properties files, and then run 
without user interaction. 

To run each Installer program, you would type its name — ladbinstall.bin or 
lafrminstall.bin — at the UNIX command prompt. The name alone launches GUI 
mode if no properties files are present, or silent mode if properties files are present; 
the name along with the argument –i console launches the console mode. 

Preparatory Procedures 
Before installing AppsRules, ensure that the following requirements have been met: 

• Grant the following APPS schema objects the execute privilege to the XXLAAPPS 
schema: 

– FND_FILE — Package Spec and Body 

– FND_PROFILE — Package Spec and Body 
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• Confirm that Java is in your path. Type the following at the UNIX command 
prompt: 
which java  

• Verify that you use Java version 1.3 or higher. Type the following at the UNIX 
command prompt: 
java -version 

If more than one copy of Java exists on your system, verify the version of the 
copy in the opt directory (for example, /usr/opt1.3/bin/java). 

• Ensure that the Oracle Advanced Security product is installed. (LogicalApps uses 
DBMS_Obfuscation for encrypting the password.) Type the following at the 
UNIX command prompt:  
adapters 

Look for Oracle Security Server Authentication Adapter among the return values. 
• Each of your database server, forms server, and concurrent manager server may 

run on its own host machine. If so, complete the following tasks to confirm that 
the host machines communicate properly: 
– Send a file via FTP from the database server to the concurrent manager 

server, and from the concurrent manager server to the forms server. 
– Perform a remote execution of the shell file, by any of the following 

methods: Enable rsh (remote shell), enable ssh (secured shell), have a 
common mount point, manual. 

Sizing Considerations 
Ensure that your forms server has 100 megabytes (MB) of disk space for AppsRules 
files, and that the database server has 100 MB of disk space for AppsRules executable 
files.  

Moreover, the XXLAAPPS schema requires the following amounts of disk space: 

• 100 MB for most AppsRules database tables.  

• An additional 1 gigabyte (GB) for two temp tables used in AppsAudit processing 
— LAAD_AUDIT_KEYS and LAAD_AUDIT_VALUES. 

• An additional amount for two tables that hold “user conflicts” generated by 
AppsAccess. The space requirement varies according to the number of conflicts 
a system may generate. The first table, LAA_USER_CONFLICT_ENTITIES, holds the 
most recent “snapshot,” or set of conflicts; the other, LAA_USER_CONFLICT_ 
ENTITIES_H, is a history table that holds archived snapshots. So one would, in 
effect, want to allow for double the number of conflicts that may be generated. 
The largest LogicalApps clients generate approximately 5,000,000 conflicts and 
so need to allow for 10,000,000, and 2 GB of disk space meets this requirement. 

Finally the APPS (Oracle Applications) schema requires space to encompass shadow 
tables used by AppsAudit — one-third of the space taken by each table that is audited. 
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Downloading Installation Files 
To begin the installation process, download the file LOGICALAPPS.zip to a temporary 
directory on your local system from the FTP site provided by LogicalApps. From it, 
extract the two files — ladbinstall.bin and lafrminstall.bin — you will run for database 
and forms installation. If you intend to use the silent installation mode, also extract 
the two files from which the Installers will read parameters — ladbinstall.properties 
and lafrminstall.properties. 

Preparing Properties Files 
If you intend to run the Installer programs in silent mode, you need first to edit the 
two properties files you extracted from LOGICALAPPS.zip, inserting information spe-
cific to your installation. (If you intend to use GUI or console mode, you don’t need 
the properties files, and you can ignore this section.) 

To insert values in the files, use a text editor such as vi. Each file consists of a series 
of name-value statements, each of which sets a parameter name equal to a value and 
each of which is preceded by an explanatory comment. (Each comment begins with a 
# symbol.) In each statement, edit information to the right of an equals sign; do not 
(with one exception, discussed below) modify text to the left of the equals sign.  

You insert into the files exactly the same information as you would supply in response 
to prompts if you were to run the Installers in GUI mode. For detailed descriptions 
of that information, see Chapter 2, “Installing AppsRules Suite.”  

The two properties files — ladbinstall.properties (database) and lafrminstall.properties 
(forms) — share many parameters, which correspond as follows to the GUI prompts 
discussed in Chapter 2: 

• CUST_NAME and LICENSE_KEY:  Prompts in the License Key window, step 1 on 
page 7 (database), or step 1 on page 11 (forms). 

• #STAGE_DIR: Prompt in the Staging window, step 2 on page 7 (database), or step 
2 on page 12 (forms).  

This statement is the exception, noted above, to the rule that you should leave 
parameter names (to the left of the equals sign) intact. In the assumption you will 
want the Installers to set  default staging directories, this statement is commented 
out in the properties file. To use the statement, you must not only supply a stag-
ing directory path to the right of the equals sign, but also delete the # symbol at 
the beginning of the statement. 

• DB_HOST_NAME, DB_SID, and DB_PORT: Prompts in the Database Host window, 
step 3 on page 8 (database), or step 3 on page 12 (forms). 

• DB_XXLAAPPS_SCHEMA_NAME, DB_XXLAAPPS_PASS, DB_APPS_SCHEMA_NAME, 
and DB_APPS_PASS: Prompts in the Database Schema window, step 4 on page 8 
(database), or step 4 on page 12 (forms). 

Another exception: The database-installation window does not prompt for the 
Oracle Applications schema name, although the forms-installation window does. 
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The properties file requires it (typically APPS) as the value for the DB_APPS_ 
SCHEMA_NAME parameter. 

• XXLAAPPS_SHORT_NAME and APPL_TOP: Prompts in the Application TOP win-
dow, step 5 on page 9 (database), or step 5 on page 12 (forms). 

• ENVFILE and ADOVARS: Prompts in the Environment window, step 6 on page 10 
(database), or step 6 on page 13 (forms). 

The ladbinstall.properties file contains one parameter — INDEX_TABLESPACE — that 
does not appear in lafrminstall.properties. This parameter corresponds to the Index 
Table Space prompt in step 4 on page 8. 

The lafrminstall.properties file contains two parameters that do not appear in the 
ladbinstall.properties file. These two parameters correspond as follows to the GUI 
prompts discussed in Chapter 2: 

• APPSORA: The final prompt in the Environment window, step 6 on page 13. 

• CUSTOM_CHOICE: The prompt in the CUSTOM.pll window, step 7 on page 13. In 
the properties file, any value other than No (case-sensitive) is equivalent to Yes.  

Finally, both files contain a parameter that does not correspond to any GUI prompt. 
For you to run the Installers in silent mode, an INSTALLER_UI parameter must be set 
to the value silent. This is the default; don’t change it. 
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Chapter 2 

Installing AppsRules Suite  

In broad terms, the AppsRules Suite installation process involves four steps: 
1 Create a tablespace for LogicalApps indexes, and a custom database user/schema. 

LogicalApps recommends strongly that the user/schema be named XXLAAPPS.  
2 Run the Installer program to place LogicalApps tables, packages, sequences, and 

workflows on the database server. All LogicalApps table names begin with the prefix 
LA, and all tables reside in the LogicalApps schema (typically XXLAAPPS). The data-
base server installation must precede the forms server installation. 

3 Run the Installer program to place LogicalApps forms on the forms server. All 
custom forms are located in the $XXLAAPPS_TOP/forms/US directory.  

4 Configure a remote compilation feature, which makes libraries resident on the 
concurrent sever available to the forms server. 

Creating a User and Tablespace 
After extracting installation files from LOGICALAPPS.zip and editing the properties 
files if you intend to use silent mode (see “Downloading Installation Files” and “Pre-
paring Properties Files”), create the LogicalApps tablespace and database 
user/schema. The latter must be granted the connect and resource privileges in the 
Oracle Applications database. LogicalApps recommends using the name XXLAAPPS 
for the new user, and creating all LogicalApps database objects in the XXLAAPPS 
schema. 
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The following is a sample SQL script that can be used to create the user: 
CREATE USER XXLAAPPS 
IDENTIFIED BY XXLAAPPS 
DEFAULT TABLESPACE &DEF_TSPACE 
TEMPORARY TABLESPACE &TMP_TSPACE 
QUOTA UNLIMITED ON &DEF_TSPACE 
QUOTA 0K ON SYSTEM; 

GRANT CONNECT TO XXLAAPPS; 
GRANT RESOURCE TO XXLAAPPS; 

Allocate a minimum of 80 MB of space, 40 on the tmp directory and 40 on the file 
system from which the installer is to be launched. 

Installing Database Server Components 
To install database server components of AppsRules, run the file ladbinstall.bin: 

1 Transfer the ladbinstall.bin file to the database server, via FTP in binary mode. 
Use the applmgr account. 

2 Use applmgr to log in to the database server. Ensure that the user (login ID) has 
write and read privileges on $APPL_TOP. 

3 Execute the environment file, if it is not included in the profile: 
$. $APPL_TOP/$APPLFENV 

4 Set the execute permission on ladbinstall: 
$ chmod +x ladbinstall.bin 

5 Execute ladbinstall.bin: 
• To run in GUI or console mode, ensure that ladbinstall.properties is absent 

from the directory where ladbinstall.bin resides. To run in silent mode, be 
sure that both files are in the same directory. 

• Use the name ladbinstall.bin as the command to run in GUI or silent mode. 
Add the argument –i console to run in console mode. 

All three Installer modes require the same information; GUI and console prompt for 
it, and silent reads it from files. If you choose GUI mode (as shown in the following 
procedure), you can perform these operations in each of the windows: 
• Review a brief description of the information you need to provide. 
• Click on the Help button to open a window that provides a more expansive 

description of the information you need to provide. (After you review this 
information, click on the Close button to exit the Help window.) 

• Type installation information in the labeled text boxes (or accept default values). 
• When you complete one window, click on the Next button to move from it to 

the next window. 
• Click the Previous button if you wish to return to a window you completed earlier. 
• Note that titles of windows you have completed appear in black along the left of 

each window; those yet to be completed are shown in grey. 
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To complete the database server installation: 

1 Enter your customer name and license key, as LogicalApps provided them to you. 
The fields are case-sensitive. When you click Next, a message displays the applica-
tions you are licensed to install; click the OK button to clear the message. 

 
2 Specify a staging directory — a temporary location for source files: 

 
The Installer suggests a default directory; its name is a timestamp for the moment 
you perform the installation, with DB (for database). If you wish to select another 
directory, click the Choose button and, in a Select a Folder window, navigate to 
the directory you want. If you specify a nonexistent directory, the Installer creates 
that directory. If you navigate away from the default directory and want to return 
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to it, click on the Restore Default Folder button. Make a note of the directory 
name; you’ll need it later, when you configure remote compilation. 

3 Verify the default values for the host name, SID (service identifier), and network 
port of the Oracle Applications database server, which the Installer takes from 
the shell environment. If the defaults are not correct, enter correct values. 

 
4 Supply log-on values for the LogicalApps and Oracle Applications (APPS) schemas: 

 
As noted earlier, LogicalApps recommends strongly the creation of a dedicated 
schema called XXLAAPPS, and the Installer provides this value by default. If you 
follow the recommendation, accept the default; otherwise, replace it with the 
name of the schema you will use for LogicalApps database objects. Also enter 
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the passwords for the LogicalApps and Oracle APPS schemas, and the name of 
the tablespace for indexes used by LogicalApps database objects. 

5 Establish the LogicalApps TOP — the high-level directory for the storage of 
AppsRules files. Specify a directory that is the parent of the LogicalApps TOP 
and an application short name that is appended to the parent directory to form 
the LogicalApps TOP directory. 

 
By default, the Installer selects the Oracle Applications TOP as the parent direc-
tory and XXLAAPPS as the application short name. These values are recommended, 
but you can change them.  

To select another parent directory, click on the Choose button and, in a Select a 
Folder window, navigate to the directory you want. If you enter the name of a 
nonexistent directory, the Installer creates that directory. To return to the default 
directory, click the Restore Default button. 

No matter what case you use to enter values, the Installer saves the short name 
as all uppercase (and adds the uppercase _TOP to create a top shell variable), and 
the directory location as all lowercase. (However, for a reinstallation, the Installer 
does not change the case of an existing application TOP.) 

If you have selected an application short name that is already in use, the Installer 
displays a warning message when you click the Next button:  

To respond to this warning: 

• Click Enter Again to return to the Application TOP form and set a new value. 

• Click Continue to accept the duplicate application short name. Doing so, how-
ever, would cause AppsRules and another application to share the name, with 
the risk that files for one application or the other might be overwritten. 

• Click Abort to abandon the AppsRules installation. 
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6 Specify paths to files that contain environment variables for the Oracle Applica-
tions shell. (The installation appends LogicalApps-specific entries to these files.) 

 
Accept the defaults, or click a Choose button and, in a Select a Folder window, 
navigate to a directory you want. If you enter the name of a nonexistent direc-
tory, the Installer creates that directory. To return to the default directory, click 
the Restore Default button. 

7 Review your selections in the Input Summary form: 

 
If you determine that any of the entries is inappropriate, you can click on the 
Previous button until you reach the form in which you selected the entry, and 
change it. (The Installer retains any entries you don’t change, even if you pass by 
them as you return to an earlier step in the installation process.)  
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8 In the Input Summary form, the label for the button at the lower right has changed 
from Next to Install. When you are satisfied with your selections in earlier forms, 
click on the Install button to complete the database server installation. 

The Installer displays error messages (if any are warranted) upon completing the instal-
lation of each LogicalApps application, and displays an overall status upon completing 
the installation of all products. If the overall status is Success, the installation has fin-
ished with no errors.  

If errors occur, they or the overall status may be classified as Warning, Nonfatal, or 
Fatal, depending on severity. The Installer recovers (restores the system to its state 
prior to the installation) for Fatal errors, but not for Warning or Nonfatal errors. For 
details about errors and the installation process, navigate to the directory from which 
the Installer ran and review two log files: LADB_LOG_timestamp.log and LADB_ERROR_ 
timestamp.log, where timestamp is the date and time at which the Installer ran. 

Installing Forms Server Components 
To install forms server components of AppsRules, run the file lafrminstall.bin: 

1 If the database and forms servers run on the same host, re-source the environ-
ment by opening a new shell.  

2 Transfer the lafrminstall.bin file to the forms server, via FTP in binary mode. 
Use the applmgr account.  

3 Use applmgr to log in to the forms server. Ensure that the user (login ID) has 
write and read privileges on $APPL_TOP. 

4 Execute the environment file, if it is not included in the profile: 
$. $APPL_TOP/$APPLFENV 

5 Set the execute permission on lafrminstall: 
$ chmod +x lafrminstall.bin 

6 Execute lafrminstall.bin:.  

• To run in GUI or console mode, ensure that lafrminstall.properties is absent 
from the directory where lafrminstall.bin resides. To run in silent mode, be 
sure both files are in the same directory. 

• Use the name lafrminstall.bin as the command to run in GUI or silent mode. 
Add the argument –i console to run in console mode. 

Most windows (or console prompts) for the forms installation are identical to those 
for the database installation. If you select GUI mode, each window enables you to per-
form the same operations as you could in the database-server Installer (see page 8).  

To complete the forms server installation: 

1 In the License Key window, once again enter the customer name and license key 
provided to you by LogicalApps. These are the same as the values for database-
server installation. Again, when you click the Next button a message displays the 
applications you are licensed to install; click the OK button to clear the message. 
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2 In the Staging form, once again select a directory for the temporary placement of 
source files. The Installer once again suggests a default — its name a timestamp for 
the moment you perform the installation, along with FRM (for forms).  
If you wish to select another directory, click on the Choose button. In a Select a 
Folder window, navigate to the directory you want. If you specify a nonexistent 
directory, the Installer creates that directory. If you navigate away from the default 
directory and want to return to it, click on the Restore Default Folder button. 

3 In the Database Host form, select the database host name used where the data-
base installation has been run, and the appropriate SID and port values. 

4 In the Database Schema window, there is no longer an Index Table Space field 
(as it would be inapplicable to forms installation), but where the database-server 
Installer requested only a password for the Oracle Applications schema, the forms-
server Installer asks for a name as well: 

 
For the Apps Schema field, accept the default value, APPS. (This needs to match 
the database-server value, which is hard-coded.) For each of the remaining fields, 
enter the same value as you entered for the database installation. 
Once again, LogicalApps recommends the creation of a dedicated schema called 
XXLAAPPS. To follow this recommendation, accept the default value; otherwise re-
place it with the name of the schema you will use for LogicalApps database objects. 
Also enter the passwords for the LogicalApps and Oracle APPS schemas. 

5 In the Application TOP form, establish the LogicalApps TOP for the forms server 
— the highest-level directory for the storage of AppsRules files. Specify a directory 
that is to serve as the parent of the LogicalApps TOP, and an application short name 
that is appended to the parent directory to form the LogicalApps TOP directory. 
The Installer defaults to the forms-server-specific Oracle Applications TOP as 
the parent directory and XXLAAPPS as the application short name. These values 
are recommended. 
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Ensure that the application short name for the forms server is the same as the data-
base server’s. If you wish to select another parent directory, click on the Choose 
button and, in a Select a Folder window, navigate to the directory you want. If 
you enter the name of a nonexistent directory, the Installer creates that directory. 
To return to the default directory, click the Restore Default button.   

No matter what case you use to enter values, the Installer saves the short name 
as all uppercase (and adds the uppercase _TOP to create a top shell variable), and 
the directory location as all lowercase. (However, for a reinstallation, the Installer 
does not change the case of an existing application TOP.) 

The forms-server Installer, like its database-server counterpart, presents a warn-
ing if you select an application short name that is already in use and it presents 
the same response options: 

• Click Enter Again to return to the Application TOP form and set a new value. 

• Click Continue to accept the duplicate application short name. Doing so, how-
ever, would cause AppsRules and another application to share the name, with 
the risk that files for one application or the other might be overwritten. 

• Click Abort to abandon the AppsRules installation. 

6 In the Environment form, specify paths to files that contain environment var-
iables for the Oracle Applications shell (the first two prompts) and for forms 
paths (the APPSORA prompt). Accept the defaults, or click a Choose button and, 
in a Select a Folder window, navigate to a directory you want. If you enter the 
name of a nonexistent directory, the Installer creates that directory. To return to 
the default directory, click the Restore Default button. In any case select values 
that are appropriate for the forms server. 

7 When you complete the Environment form, the forms server Installer presents a 
CUSTOM.pll form: 
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Forms server installation requires that an existing CUSTOM.pll file be modified so 
that it can link to an LACUSTOM.pll file. If you select Yes, the Installer backs up 
your existing CUSTOM.pll, and then overwrites the original with a modified copy 
that contains the necessary links to LACUSTOM.pll. (The backup copy has a time-
stamp appended to the .pll file extension.) If your existing CUSTOM.pll contained 
any customization, a Yes selection in this form would require you to copy your 
customizations manually from the backup file to the LogicalApps-provided 
CUSTOM.pll. 

If you select No, the Installer retains your existing CUSTOM.pll. In this case, you 
need to edit the file to insert links to LACUSTOM.pll (see below). 

8 In the Input Summary form, review the selections you have made. If you deter-
mine that any of the entries is inappropriate, you can click on the Previous but-
ton until you reach the form in which you selected the entry, and change it.  (The 
Installer retains any entries you don’t change, even if you pass by them as you 
return to an earlier step in the installation process.)  

9 When you are satisfied with the selections you have made in preceding forms, 
click on the Install button in the Input Summary form to complete the forms 
server installation. 

The Installer displays error messages (if any are warranted) upon completing the instal-
lation of each LogicalApps application, and displays an overall status upon completing 
the installation of all products. If the overall status is Success, the installation has fin-
ished with no errors.  

If errors occur, they or the overall status may be classified as Warning, Nonfatal, or 
Fatal, depending on severity. The Installer recovers (restores the system to its state 
prior to the installation) for Fatal errors, but not for Warning or Nonfatal errors. For 
details about errors and the installation process, navigate to the directory from which 
the Installer ran and review two log files: LAFRM_LOG_timestamp.log and LAFRM_ERROR_ 
timestamp.log, where timestamp is the date and time at which the Installer ran. 

CUSTOM.pll Modifications 
If you chose (in step 7) not to overwrite your CUSTOM.pll file, edit the CUSTOM.pll 
file. (If you selected Yes in step 7, ignore this section and skip ahead to “Configuring 
the Remote Compilation.”) 

1 In place of the existing code for Procedure Event(event_name varchar2), substitute the 
following: 
PROCEDURE event(event_name varchar2) is  
 
  form_name varchar2(30) := name_in('system.current_form');  
  block_name varchar2(30) := name_in('system.cursor_block');   
  field_name varchar2(30) := name_in('system.current_item'); 
  function_name varchar2(30); 
  parameters  varchar2(2000); 
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begin  

  if (event_name = 'ZOOM') then    
    la_enhncmtmgr_pkg.la_zooms(form_name,block_name,function_name, 
        parameters); 
      if function_name is not NULL 
      then 
        if parameters is null then 
          fnd_function.execute(function_name,'Y','N'); 
        elsif 'ZOOMSPECIAL' = substr(parameters,1,11) then  
          lacustom.event('ZOOMSPECIAL'); -----new code 081903 
      else 
        parameters := lazoom.zoom_event(parameters); 
        fnd_function.execute(function_name,'Y','N',parameters); 
      end if; 
  end if; 
-----------------------------------WNF 
  elsif (event_name='WHEN-NEW-FORM-INSTANCE') then 
 lacustom.event('WNF'); 
---------------------------WNB 
  elsif (event_name = 'WHEN-NEW-BLOCK-INSTANCE') then 
 lacustom.event('WNB'); 
------------------------------WNI 
  elsif (event_name = 'WHEN-NEW-ITEM-INSTANCE') then 
 lacustom.event('WNI'); 
------------------------WNR 
  elsif (event_name = 'WHEN-NEW-RECORD-INSTANCE') then  
 lacustom.event('WNR'); 
------------------------WNV 
  elsif (event_name = 'WHEN-VALIDATE-RECORD') then 
 lacustom.event('WVR'); 
------------------------ 
  elsif (substr(event_name,1,7) = 'SPECIAL') then 
 execute_menu(event_name); 
-------------------------------------------- 
   else lacustom.event(event_name);   --put other events here 
   end if; 
end event; 

2 In place of the code for Function zoom_available, substitute the following: 
FUNCTION zoom_available return boolean is 
    v_enabled varchar2(20); 

  begin   --x 
    v_enabled := lazoom.zoom_enabled; 
    IF v_enabled = 'TRUE' THEN  
      return TRUE;  
    else  
      return FALSE;  
    end if;  
  RETURN NULL;  
  end zoom_available; 

3 Attach the following libraries. (Remove the path when attaching the libraries.) 

• LACUSTOM.pll 

• LABRSQL.pll 

4 Compile the file and ensure there are no compilation errors. 
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Servlet Mode 
If the forms server runs in servlet mode, you must edit a file to enable Oracle to 
recognize the LogicalApps TOP you selected during installation (see step 5 on page 
14).  

To determine whether the forms server runs in servlet mode, identify the file set by 
the Oracle environment variable $FORMS600_WEB_CONFIG_FILE. Open that file and 
search for its serverURL entry. If that entry is set to the value /forms/formservlet, the 
forms server runs in servlet mode. If the entry is blank, the forms server runs in 
socket mode, in which case you need not complete the following procedure. 

If the forms server does run in servlet mode: 

5 Using a text editor, open a file called formservlet.ini. The file is located either in 
$APACHE_TOP/Jserv/etc or in $IAS_ORACLE_HOME/Apache/Jserv/etc. 

6 In the formservlet.ini file, look for a block of entries bounded by the lines #Begin 
Customization and #End Customization. 

7 Add the following entry anywhere between the Begin and End Customization 
lines: 
XXLAAPPS_TOP=$APPL_TOP/xxlaapps/11.5.0 

Note, however, that the value XXLAAPPS is correct in this entry only if you have 
accepted the default LogicalApps application short name during installation. If 
not, then in each of the two places that the value XXLAAPPS appears in this entry 
(whether in upper or lower case), substitute the short name you created in step 5 
on page 14. 

8 Save and close the file. 

Configuring the Remote Compilation 
To finish the installation, you must configure a remote compilation feature, which 
makes libraries resident on the concurrent sever available to the forms server. 

1 Log on to the database server. 

2 Source out the Oracle Applications shell environment.  

3 Navigate to the $XXLAAPPS_TOP/bin directory (a subdirectory, called bin, of the 
LogicalApps TOP directory, which you established in step 5 of the database instal-
lation process).  

4 Grant the execute permission on a file called laconfig.sh: 
$ chmod +x laconfig.sh 

5 Run the laconfig.sh file: 
$ laconfig.sh  
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Running the laconfig.sh file produces a series of command-line prompts. Respond to 
them as follows: 

1 You are prompted to enter the LogicalApps application short name. If that name 
is other than XXLAAPPS, type it and press the Enter key. (Case is not significant.) 
If the short name is XXLAAPPS, simply press the enter key in response to the 
prompt. 

2 A prompt displays a path to a Java executable; you must confirm that this is the 
path to the Java executable used by Oracle Applications. It is, if you sourced out 
the Oracle Applications shell environment before running the laconfig.sh file (no 
matter how many Java executables reside on your system). It may not be, if you did 
not source out the Oracle Applications shell environment and have more than one 
Java executable on your system. 

If the prompt displays the path to the Oracle Applications Java executable, type 
Y (for yes) and press the Enter key. If not, type N (for no) and press the Enter 
key, then type the full path to the Java executable used by Oracle Applications and 
press the Enter key again. 

3 A prompt displays a path for a file that sets the Oracle Applications environment; 
you must confirm that it is correct. The default value is taken from the shell as 
$APPL_TOP/$APPLFENV, and this selection is always safe; to accept it, press Y 
(for yes) and press the Enter key. But what’s really at issue is the file that sets the 
LogicalApps TOP, which is a subsidiary file of $APPLFENV. You may wish to spec-
ify it instead; if so, type N (for no), then type the full path to the appropriate file 
and press the Enter key. 

4 The following prompt appears: 
Choose your node configuration from below: 
1.  All servers (CM/Forms) share the same application top  
    directory 
2.  Forms server has different application top file system than  
    concurrent managers  
3.  Exit Program 

Enter 1 if all database, forms, and concurrent servers exist under a single applica-
tion TOP, or 2 if each exists under its own application TOP (regardless of whether 
they reside on a single machine or more than one).  

5 You are prompted to enter the number of distinct application TOPs used by 
forms servers. Type the number and press the Enter key. 

6 For each of the application TOPs you include in the count in step 5, you are 
prompted to select a method for transferring files to the application TOP direc-
tory. Enter one of the following and press the Enter key: 
• 1 for secured shell (ssh) 
• 2 for remote execution (rexec) 
• 3 for telnet 
• 4 for local file system (copy) 
• 5 for manual 
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7 For each application TOP, you are prompted for supporting information if you 
have selected any of the first four access methods. (Method 5, manual, requires 
no supporting information.) 

• Server host name if you selected option 1, 2, 3, or 4 

• Full path to LogicalApps binary files if you selected option 1, 2, 3, or 4 

• User ID if you selected option 1, 2, or 3 

• Password if you selected option 3 

Entries are validated, so that if you enter incorrect supporting information you 
are prompted to try again. 

Once you have finished executing the laconfig.sh file, verify that the following files 
exist and make sure both the Java path and Classpath are set correctly: 

• Database server (under $XXLAAPPS_TOP/bin): LAGENLIB.prog, LAMIGRATE.prog, 
LAIMPORT.prog 

• Forms server: LAFORMSGEN.prog 
Finally, if you want to enable migration (the ability to port AppsRules configurations 
from one instance to another) with password security: 

1 Navigate to \\System Administration Responsibility\Profile\System. 
2 Query for the LAAPPS: Enable Migration Security profile option. 
3 Set the value to Yes at site level. (This can be controlled further at the responsi-

bility and user levels.) 

Bouncing the Servers 
When you finish configuring the remote compilation feature, bounce both the form 
server and the concurrent manager server. 
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Chapter 3 

Postinstallation Tasks  

Once the installation is complete, you must perform additional tasks specific to the 
applications you’ve installed. 

SQL Rule Compilation 
From within AppsRules, you must run a option to compile SQL rules: 
1 Log on to the LogicalApps responsibility in Oracle Applications. In that respon-

sibility, select AppsRules. 
2 Once the AppsRules form is open, click on Tools in the menu bar, and then 

AppsRules Compile All Active SQL Rules in the Tools menu. 
3 A pop-up message informs you of an ID number for the concurrent request that 

executes the SQL rule compilation. Make a note of the number, and then click 
on the OK button to close the message. 

4 Verify that the request is successfully completed.  
a Click on View in the menu bar, then on Requests in the View menu.  
b A Find Requests form opens. In it, click on the Specific Request radio button. 

Type the ID number of your concurrent request in the Request ID field, and 
click on the Find button. 

c A Requests form opens. In the row displaying information about your 
request, ensure that the entry in the Phase field is Completed (you may need to 
click the Refresh Data button), and the entry in the Status field is Normal. 
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d Click on the × symbol in the upper right corner of the Requests form to 
close it. 

Associate LogicalApps Functions 
When AppsAccess is installed, an Assign Responsibilities option is available in the 
Actions menu of the Oracle Users form (available from the System Administrator 
responsibility). If the Assign Responsibilities option is inactive, use a Mass Associate 
feature, available in AppsForm or AppsFlow, to associate a function called AppsAccess 
Activate Responsibilities with either the responsibility or the menu from which you 
gain access to the Users form.  

A Mass Associate utility enables you to add LogicalApps form functions to Oracle 
Navigator menus or to responsibilities which they are not already associated. For 
information on using the Mass Associate feature, see the user’s guide for AppsForm 
or AppsFlow. 

Access Monitoring 
An Access Monitoring feature enables users to request temporary access to database 
tables or to Oracle responsibilities. Before direct access to database tables can be re-
quested, database administrators must create database IDs to be assigned to users who 
receive access. Each of these user IDs must begin with the letters LAAG. Although 
they may otherwise follow any format, the recommended format is LAAGDBx, 
where x is a unique number.  

After the IDs are created, an LAAG DB Users Synchronization Process concurrent 
request must be run in the LogicalApps responsibility of Oracle Applications; this 
enables Access Monitoring to recognize the IDs and display them so that they are 
available for selection. The request takes no parameters. 

To submit LAAG DB Users Synchronization Process: 

1 Log on to the LogicalApps responsibility in Oracle Applications. 
2 Click on View in the Oracle Applications menu bar, then on Requests in the 

View menu. The Find Requests form appears. 
3 Click the Submit a New Request button. At the prompt, select Single Request 

and click OK. The Submit Request form appears. 
4 In the Name list of values, select LAAG DB Users Synchronization Process. 

Click on the OK button. 
5 In the Submit Request form, click on the Submit button. 
LAAG Dequeue Process is a Oracle Concurrent program that reads the database 
changes captured in the Advanced Queue and persists for reporting. 

This program should be scheduled to run periodically from the completion of the 
last run. The interval is dependant on the amount of data generated and the 
frequency needed to capture the changes for reporting. 
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To submit LAAG Dequeue Process: 

1 Log on to the LogicalApps responsibility in Oracle Applications. 
2 Click on View in the Oracle Applications menu bar, then on Requests in the 

View menu. The Find Requests form appears. 
3 Click the Submit a New Request button. At the prompt, select Single Request 

and click OK. The Submit Request form appears. 
4 In the Name list of values, select LAAG Dequeue Process. Click on the OK 

button. 
5 In the Submit Request form, click on the Submit button. 

AppsFlow 
To use AppsFlow, run the Synchronize WF LOCAL Tables concurrent program: 

1 Log on to the System Administrator responsibility in Oracle Applications. 
2 Click on View in the Oracle Applications menu bar, then on Requests in the 

View menu. The Find Requests form appears. 
3 Click the Submit a New Request button. At the prompt, select Single Request 

and click OK. The Submit Request form appears. 
4 In the Name list of values, select Synchronize WF LOCAL Tables. Click on the 

OK button. 
5 A Parameters form appears. Enter the following values, then click on the OK 

button: 
• Orig System: ALL 

• Parallel Processes: 1 

• Logging Mode: LOGGING 

• Temporary Tablespace: Choose an appropriate temporary tablespace. 

6 In the Submit Request form, click on the Submit button. 

AppsAudit 
To use AppsAudit, complete three tasks. First, set the AuditTrail:Activate profile 
option to Yes: 

1 Log on to the System Administrator responsibility in Oracle Applications. 

2 In the Navigator, select Profile, then System.  

3 In the Find System Profile Values form, select AuditTrail:Activate in the Profile 
list of values. Then click on the Find button. 
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4 Ensure that the AuditTrail:Activate option is set to Yes at the Site level: 

 
Second, add the LACSVREPORT style to the printer you will use for AppsAudit: 
1 In the System Administrator responsibility, select Install, then Printer, then Register.  
2 A Printers form appears. In its Printer list of values, select the printer you wish 

to use with AppsAudit. Note the value that appears in the Type field when you 
select the printer, and then click on the Printer Types button. 

3 A Printer Types form appears. In its Type field, query for the Type you noted in 
step 2. (Press the F11 key; enter the Type value in the Type field; press Ctrl+F11.) 

4 In the Style list of values, select LACSVREPORT. (The software automatically 
supplies an associated value under Driver Name.) 

 
5 Click on File in the menu bar, then on Save in the File menu. 
Third, modify the report style: 
1 Still in the System Administrator responsibility, select Concurrent, then Program, 

then Define. 
2 A Concurrent Programs form appears. In its Program field, query for 

LogicalApps AppsAudit Report. (Press the F11 key; enter LogicalApps AppsAudit 
Report in the Program field; press Ctrl+F11.) 
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3 The Style field displays the value Landwide. Change this to Landscape. 

  
4 Click on File in the menu bar, then on Save in the File menu. 

AppsAccess and AppsControl 
To use AppsAccess you must import two xml files, and to use AppsControl you 
must import three xml files. To do so, you use a migration utility, which the Installer 
programs set up automatically as a part of the installation process. 

First, ensure that the migration utility is configured correctly: 

1 Log on to the LogicalApps responsibility in Oracle Applications. In that respon-
sibility, select AppsRules. 

2 Once the AppsRules form is open, click on LogicalApps Utilities in the menu 
bar, then on Migration Setup in the Utilities menu.  

3 A Migration Utility form appears. Ensure that the Setup Host Names tab is selected: 
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4 Confirm that the database server host name (the one selected in step 3 of the 
database server installation process) is displayed in the Host Name column. The 
Installer program should have inserted this value during installation. 

5 Click on the Setup Instances tab: 

 
6 Ensure that appropriate values are displayed in the Host Name, Instance (SID), 

Port Number, User Name, and Password columns. (The first three values are 
those specified in step 3 of the database server installation process, and the last 
two are those specified in step 4.) Again, the Installer should have inserted these 
values automatically. 

7 Having confirmed these values (or, if necessary, entered them), close the 
Migration Utility form. 

The five xml files are located in subdirectories of the staging directory you selected in 
step 2 of the database server installation process. For AppsAccess the files are located 
in StagingDirectory/AppsAcces/db/scripts, and include the following: 
• laa_apps_access_rule.xml 
• laa_apps_access_flow.xml 
For AppsControl the files are located in StagingDirectory/AppsControl/db/scripts, and 
include the following: 
• appscontrol_notification.xml 
• appscontrol_approval.xml 
• appscontrol_reject.xml 
For each application, the files must be imported in the order shown. Complete the 
following procedure once for each of the files: 
1 With AppsRules open, click on LogicalApps in the menu bar, then on Import 

from File in the Utilities menu. An Import from File form appears (as shown at 
the top of the next page). 

2 In the directory box, type the path to the folder that contains the import file. 
3 In the File Name box, type the name of the file you want to import. 
4 Select a value for Debug Level. Ordinarily, select Low; select High instead if you 

need to uncover the cause of a failed import. 
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5 Click on the Import button. A concurrent request message displays the ID num-

ber of the concurrent request under which the import operation is carried out. 
Click on the OK button to clear the message. 

Moreover, to use the AppsControl Wizard, run Create Audit Objects: 

1 Log on to the LogicalApps responsibility in Oracle Applications. In that respon-
sibility, select AppRules.  

2 Once the AppsRules form is open, click on LogicalApps Utilities in the menu 
bar, and then AppsAudit Create Audit Objects in the LogicalApps Utilities menu.  

Special Cases – Different Hosts 
If the database server and concurrent manager server are on different hosts, make 
the following changes to the TKprof script (LATKPROF.prog), which is located in the 
LogicalApps binary directory on the concurrent manager server. (The changed lines 
are shown in boldface.) The value <db_login> is the database server name, and the 
value <db_hostname> is the user name to log on to the database server. 

#!/bin/sh 
oracle_login=$1 
tempfile=$$latkprof.txt 
temptrc=$$latkprof.trc 
echo Temp file $tempfile 
echo tkprof directory "$5" 
pwd 
tkfiles='ssh <db_login>@<db_hostname> ls $5' 
for i in $tkfiles 
do 
echo processing $i 
scp <db_login>@<db_hostname>:$i /tmp/$temptrc 
tkprof /tmp/$temptrc /tmp/$tempfile explain=$1 
cat /tmp/$tempfile 
rm /tmp/$tempfile 
rm /tmp/$temptrc 
done 
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If you have multiple APPS schemas, the LA_ENHNCMTMGR_PKG must be created as 
a synonym under each of these schemas. To perform this operation, run the 
following command: 

create synonym LA_ENHNCMTMGR_PKG for apps.LA_ENHNCMTMGR_PKG 

If this is not set, the following error message appears when a user attempts to log on 
to a read-only or MRC (multiple reporting currency) responsibility: 

la_enhncmtmgr_pkg not declared 

Special Cases – Upgrading AppsAccess 
If you are upgrading AppsAccess from an earlier version, the name of one of its con-
current programs may not have been updated correctly. To correct the program name: 

1 Log on to the System Administrator responsibility in Oracle Applications. 

2 In the Navigator, select Concurrent, then Program, then Define. The Concurrent 
Programs form opens. 

3 Query for the Conflict Data Purge program: Press F11, type the phrase LA 
AppsAccess Conflict Data Purge in the Program field, and press Ctrl+F11. 

 
4 In both the Program and Description fields, type the following new value for the 

name of the program: LA AppsAccess Archive User Conflict Data. Do not change 
any other values. 

5 Save the change: Click on File in the menu bar, and then Save in the File menu. 
Then close the Concurrent Programs form (click on the × symbol). 

If you are performing a new installation of AppsAccess, this issue does not arise; the 
program is named correctly, and you need not take any corrective action. 
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Chapter 4 

Validation  

As a part of the installation process, the Installer programs complete several 
“behind-the-scenes” tasks. Open Oracle Applications forms to confirm that these 
tasks have been completed. (As you perform these validation steps, you may be 
instructed to “query for” a value. If so, press the F11 key, type the specified value in 
a specified field, and press Ctrl+F11.) 

1 Log on to the System Administrator responsibility in Oracle Applications. 

2 Select Application, then Register.  

3 In the Application field, query for LogicalApps Custom. The form should 
contain the following values: 
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4 Switch to the Application Developer responsibility. (Select File in the menu bar, 
then Switch Responsibility in the File menu; then select Application Developer 
in the Responsibilities form.) In the Application Developer Navigator, double-
click on Application, then Form. In the Form field, query on LABIZ. The form 
should contain the following values: 

 
5 Switch back to the System Administrator responsibility. In its Navigator, select 

Security, then Responsibility, then Request. In the Request Groups form, query 
for the LogicalApps Request Group. The form should contain the following 
values: 
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6 Still in the System Administrator responsibility, select Application, then Menu in 
the Navigator. In the Menus form, query for LAAR_NAVIGATE and confirm the 
values shown in the illustration at the top of the next page. (The illustration is a 
composite, showing entries that would appear if you were to use the scroll bar in 
the Menus form.) 
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7 In the System Administrator Navigator, select Security, then Responsibility, then 
Define. In the Responsibilities form, query for LogicalApps. (This is the respon-
sibility you would assign to Oracle Applications users so that they can use 
LogicalApps applications.) 

 
Switch to the LogicalApps responsibility and, in the LogicalApps Navigator, select 
AppsRules. Then do the following: 

1 Select Tools in the menu bar, then on AppsRules Configurations in the Tools 
menu. 

2 An AppsRules Configurations form appears. Confirm that a value displayed in 
the UTL Path field: 

 
3 The UTL Path field value should match the name of one of the directories set 

for UTL PATH in your environment. To confirm that it does, run the following 
SQL query to generate a list of those directories: 
select value from gv$parameter where name='utl_file_dir' 
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Finally, confirm that appropriate values have been set for AppsRules libraries: 

1 With AppsRules open, click on LogicalApps Utilities in the menu bar, then on 
AppsRules Libraries in the LogicalApps Utilities menu. 

2 With a LogicalApps Libraries form open, click on Tools in the menu bar, then 
on Value Sets in the Tools menu. 

3 In the Name field of the Find Value Set form, enter the value LA% and click on 
the Find button. 

 
4 Select (one at a time) the LAAC_CATEGORY, LAAR_LIBRARY_MODULES, and 

LAAR_LIBRARY_THEME entries. For each, confirm that a Segment Values form 
displays the value ALL in the Values field of the Values, Effective tab. For 
example: 
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Installation History 
You can review information about the installation of files for your AppsRules imple-
mentation. To do so: 

1 Log on to the LogicalApps responsibility. 

2 In the Navigator, select Install History. The Installation History form appears: 

 
Each row provides information about the installation of a LogicalApps program 
element — for example, the top row in this illustration shows that the AppsCore 
element for version 7.1 of the forms server was successfully installed. Because 
there are several elements for each of the forms and database servers, a single 
installation of AppsRules fills multiple rows in the grid — for example, all of the 
rows in this illustration pertain to an installation performed on the seventh of July. 

3 To view a list of the files installed for a given element, click on the row for that 
element and then on the Installed Files button. The following form appears: 

 
Click on the Close button to clear this form. 
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4 Finally, to review information about all currently installed files (regardless of 
whether they were added in the most recent installation), click on the Current 
File Versions tab: 

 
5 To close the Installation History form, click on its × symbol. 
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